DFM Concurrent Costing® Software Tutorial

Die Casting Analysis

Start a new analysis

For the purposes of this tutorial we will estimate the cost per part of manufacturing 200,000 of the disk drive casings shown

here:

front back

The material is to be ZA-8 cast zinc alloy and the process Hot-chamber die casting.

1. Start DFM Concurrent Costing. In the Part box, type Casing in the Part name field, 001 for the Part number and 200000 for

the Life volume.

2. Inthe Envelope shape box, click the hollow block envelope shape. Enter the Approximate envelope dimensions in inches as

follows: 1.02, 5.7 and 7.24. The average thickness is 0.079.

Approximate envelope dimensions, in.

e Forming
1.020
l—l & direction

5.700 i 7.240 i
Average thickness | 0.079

3. Click the button Select process and material...
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4.

In the Process and material selection dialog, expand the Die casting process to show its contents. Click Hot-chamber to
select the process. For the material, expand the category Zinc alloy and click the material name ZA-8 cast zinc alloy.

1 Process and material selection

O

pod

Select process

Assembly fabrication
Automatic assembly
Blow molding
4 Die casting
Cold-chamber
Hot-chamber
Forging, hot
Injection malding
Inwestment casting
Machining or cut from stock
Machining cell
Metal extrusion
Metal injection molding
Plastic extrusion
Powder metallurgy

Printed drcuit board assembly

[Dpeeg [ T J——

Select a manufacturing profile

23A BDI North America
23A BDI China

Select material

b Magnesium alloy
4 Zinc alloy
Generic zinc alloy

ZA-8 cast zinc alloy

5. Click the OK button to proceed with the selection and return to the first window.

6. Observe that the Process Chart now includes the material, the process, the machine setup and the process operations.

4 Fp-8 cast zinc alloy die cast part
4 Hot chamber die casting process
4 185 Ton Hot Chamber Die Casting Machine

Die casting operation

Trimming operation
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Default data is presented in the right panel of the window, the Responses panel. You will now want to adjust the response
inputs. Each level on the Process Chart has its own Responses panel.

With Hot chamber die casting process selected, we can edit its responses. Change the Maximum thickness to 0.18 in. Hit
the Tab key to move to the next response field.
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Basic data

Batch size 25000
Owerall plant efficiency, % 85

Material cost, §/lb 0.830
Material scrap value, £/lb 0.400

Die cast operation |Autumatic w |

Maximum thickness, in. 0.180

9. Supply part geometry data as follows: the Part volume is 5.18 cu in, the Part projected area in the forming direction is 37 sq
in, the Outer perimeter is 26.2 in. and the number of Through holes in the part is 12. Also enter 18.85 in. for the Perimeter
of through holes. Note that a Geometry Calculator can be used in determining these values.

Part geometry

Part volume, in® s | 5.180
Part weight, Ib 1.228
Part projected area, in? [ 37.000
Outer perimeter, in. ¢ 26.200
Through holes : 12

Perimeter of through holes, in. 18.850

10. At any stage you can click the Calculate button in the Cost results pane to update the cost estimate. Let’s do this now.

Cost results, & Previous Current
Material 1.3432 1.9555
Setup 0.0110 0.0107
Process 0.3235 0.3426
Rejects 0.0139 0.0191
Piece part 2.3015 23278
Tooling 0.2168 0.2224
Total 2.5183 2.5502

Tooling investment 43,367 44 476

11. The default for the Surface patches response is based on the volume calculated from the initial dimensions having average
complexity. In our example, change the number of surface patches to 445.

Part complexity

Surface patches 415

12. Tab to the next section, Non-geometric features. For Tolerance choose most approx. 0.005 in/in; and accept a medium
finish for the Appearance field.
Man-geometric features

Taolerance | Most approx. 0.005 infin s |

Appearance | Medium finish ¥ |

Textured surface, % 0

13. In the Die data section, we assume a Parting line with two steps; choose 2-4 steps or simple curve from the list box.
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14. For holes that are parallel to the forming direction it is not necessary to provide side-pull mechanisms in the die; we can
leave the number of side pulls at zero.

Die data

Farting line | 2-4 steps or simple cury |
Inserts per cavity 0

Side pulls on left 0

Side pulls on right 0

Side pulls on top 0

Side pulls on bottom 0

|2 Automatically select cavities?

MNumber of cavities 1

15. The optimum number of cavities has been automatically set to a value of 1. This value is estimated from the size of the
part, life volume and machine attributes. The automatic selection of the number of cavities considers all of these effects to
result in minimization of part cost. By unchecking the Automatic Selection checkbox you can manually enter the number of
cavities. For the casing, 1 cavity is optimal. Click the Calculate button.

Cost results, § Previous Current
Material 1.9555 1.9555
Setup 0.0107 0.0107
Process 0.3426 0.3446
Rejects 0.0191 0.0191
Piece part 2.3278 2.3299
Tooling 0.2224 0.3329
Total 2.5502 2.6628

Tooling investment 44,476 66,576

16. We have now obtained an accurate cost estimate for our part. However, we can improve on the estimate even further by
looking at the machine setup and operations data.

17. Click the 130 Ton Hot Chamber Die Casting Machine entry on the Process Chart to change the Responses Panel to show
setup data.
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Machine selection

|| Automatic selection?

Machine data

Clamping force, tons

Shot capacity, in®

Dry cycle time, 5

Max. mold opening, in.
Mumber of machines per operator

for automatic operation

Machine rate, $/hr

Operator rate, §/hr

Process rate, S/hr

Rejects, %

130.00
54.900

2.50

9.060

2 |
4255
27.00

56.05

0.05

18. When Automatic selection? is checked in the box above, the software selects the smallest machine by capability to perform

the operation. Default machine data are shown for information.

19. Note the Rejects,% response field; the percentage of parts rejected following each operation is user editable. If the
operation is within a machine setup, the reject percentage is a response for the setup. The cost of rejects is shown in the

Cost results box.

20. On the Process Chart, select Die casting operation. There are group boxes on the Responses panel where you can refine
your estimate. Machine setup and Casting process data provide edit fields related to setup and machine operating

conditions.

Machine setup

Machine rate during setup, &hr

Setup operator rate, 5fhr

Setup rate, &/hr

Setup time, hr

Casting process data

Cavity life

Cost of electricity, $/kWh
Minimum required melt energy, Btu/lb

Furnace efficiency, %%

34.00
31.00

65.00

3.00

500000
0.035
144.00
70

21. In Cycle time data, you can edit the machine cycle times for your plant conditions. To update the Die casting cycle time total
after editing the cycle time fields, click the Calculate button in the Cost results pane.
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Cycle time data

Fill time, 5 0.03
Cooling time, s £.44
Die opening time, s 3.13
Part extraction time, s 2.584
Die lubrication time, s 1.66
Die closing time, s 1.25
Die casting cycle time, s 15.35

Die cost data

Die set purchase cost, § 4,758
Die set custom work, 5 4,750
Cavity/core manufacture, hrs 1237.62
Die manufacturing rate, $/hr 42.00

22. In the last group box for the die casting operation, you can change the defaults for the tooling estimate.

23. Highlight the Trimming operation on the Process Chart, and review the responses. The trimming operation in this model
does not use a machine setup. Machine rates associated with trimming are available together with the other trimming

operation variables in the responses for the trimming operation.

24. Choose Save As from the File menu and supply the File name casing. The file is saved automatically with the extension

.dfmx. Click the Save button.

Add secondary operations

We can add further operations to the process. We want to add a finish slot end milling operation to finish the pads. To add
machining steps, you first add a machine tool setup, and then machining operations from the Operation Library.

1. With the Trimming operation still highlighted on the Process Chart, choose Machine Tool Setup from the Insert menu.

2. Inthe Insert machine dialog, reveal the entries for the Vertical machining centers category by clicking its handle. Highlight
Generic CNC machining center. Click the Insert button and close the dialog. The machine tool setup and its Setup/load/

unload operation is added to the Process Chart.
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[ \
¥ Boring and drilling machines -
¥ Broaching machines
b Gear cutting machines
b Grinding machines
b Horizontal machining centers
b Lathes
¥ Milling machines
4 Vertical machining centers

[Generil: CNC machining center

Fadal VMC 2015 H5-1I

Fadal VMC 3320R-1I

Fadal VMC 40208-11

Fadal VMC &030B-11

Haas WVMC VF-1

Haas WMC VF-255YT

Haas WMC VF-355YT

Haze VMO WF-455 -

3. Highlight the Setup/load/unload entry to review its responses.
Work handling
Warkholding device | Fixture, horizontal v |
Mumber of reversals 0
Load/unload time, s 28.28
Additional down-time, s 28.28
Machine setup
Machine rate during setup, §/hr 16.90
Setup operator rate, 5/hr 31.00
Setup rate, $/hr 47.90
Basic setup time, hr 0.35
Setup time per toal, hr 0.15
Other costs

Tool, fixture or program cost, $ 0

4. Now you can add the finish face mill operation. From the Insert menu, choose Operation.

5. Adialog opens that lists the operations in the Operation Library. Expand the Machining category and then expand the Slot/
pocket end milling subcategory. Highlight the Finish multiple slot end mill operation. (We choose multiple because there
are 4 identical pads to finish.)
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1 Insert Operation

Select an operation to insert

4 Machining
¥ Boring

Drrilling

Reaming

Tapping

Die threading

Side and slot milling

Face milling

Slot/pocket end milling
Finish single slot end mill

| Finish multigle slot end mill|

Rough single slot end mill

L v = = = ¥+ =«

Rough multiple slot end mill
Rough and finish single slot &
Rough and finish multiple slof
Finish pocket end mill
Rough pocket end mill
Rough and finish pocket end
¥ Peripheral end milling
¥ Miscellaneous operations
¥ Bar feed cperations
¥ Bending

{ >

Details

Calculates the machining time and cost for finish slot end
milling multiple features.

If you spedfy inconsistent cut dimensicns appropriate
warnings are given.

Recommended cutting speeds and feeds are taken from
the library and corrected for the hardness of material.
The cutting speeds are limited by the maximum spindle
speed available.

The feed per tooth for the finish cut is estimated from
the surface roughness you specify.

Adjustments are made to the machining time to allow for
the approach and over-travel of the tool for each cut.

[ o NS [ M TN N SO T N CRI Y I T I R

Picture

6. Click the Insert button and close the dialog. The finish slot end milling operation is added to the Process Chart.

7. A partial set of responses is shown for the end milling operation. To complete the calculation of machining time, we must

8.

supply dimensional data.
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The width of each pad needing machining is 0.25 in. Supply the machined surface length of 0.5 in. Enter 4 for the number
of features milled and then select a surface roughness of 63u in (63 microinches) from the Surface roughness list box. Now
click the Calculate button to update the results.
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Operation inputs
Tool material | High-speed steel il

|¥| Include tool replacement cost?

Width of surface to be milled {wc), in. 0.250
Length of surface to be milled (lc), in. 0.500
Mumber of features milled 4.000
Surface roughness |63 pin. 1.6 pm v|
Machining data
Taool diameter, in. 0.250
Mumber of teeth 4,000
Cutting speed, ft/min 226.100
Feed per taath, in. 0.002
Feed speed, inf/min 26.009
Mumber of passes 1.000
Width per pass, in. 0.250
Special tooling cost, § 0.000

Making comparisons

To investigate alternative materials, processes or design changes you can copy an analysis.

1. Click on the tab labeled Original located above the current analysis. From the Edit menu, choose Copy, then Paste. A new
tab appears containing a copy of the Original analysis.

2. Double-click the tab to edit the name of the analysis; type Aluminum to distinguish it from Original in graphs and reports.
Type Casing-2 in the Part name field.

3. Click the Select process and material button. In the selection dialog, click Die casting, cold-chamber and, in the Aluminum
alloy category, A356 Cast aluminum. Click OK.

4. The new analysis now shows the cost associated with changing the process and material. Note that the current cost results
have updated.
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Original | Aluminum |
4 A355 cast aluminum die cast part Dynamic Costing ;? Off on
4 Cold chamber die casting process
4§00 Ton Cold Chamber Die Casting Machine PEEIEE
Die casting operation Batch size e
Trimming oparation Overall plant efficiency, % 85
4 Generic CNC machining center Material cost, $/Ib 1.230
Setup//load/unload Material scrap value, §/lb 0.500
Finish multiple slot end mil Die cast operation |Automatic ¥ |
Maximum thickness, in. 0.180
Part geometry
Part volume, in® D 5.180
Part weight, |b 0.502
Part projected area, in2 |2| 37.000
Quter perimeter, in. |:| 26.200
Through holes “_ 12
Perimeter of through holes, in. 18.850
Part complexity
Surface patches 445
Mon- tric feah
Cost results, 5 Previous Current on-geometnc teatures
Tolerance | Most approx. 0.005 infin |
Material 0.0000 1.1391
Setup 0.0000 0.0239 Appearance [ Medium finish v |
Process 0.0000 0.5350
Textured surface, % 0
Rejects 0.0151 T =
Piece part 0.0000 1.7131
Tooling 0.0000 0.5321
Total 0.0000 2.2452
Tooling investment 0 106,421

5. Notice the Cold chamber analysis chooses a much larger machine. This is because the optimal number of cavities under
the new conditions is 2 instead of 1.

All of the edited fields have been used in the new analysis, including those for the Finish multiple slot end mill operation in
the machine tool setup. When the material changed, the software used the new material’s machining data to automatically
update the operation time. In this case, the aluminum workpiece material in the second analysis is softer and the cutting
speed reaches the spindle speed limit.

6. View the totals for each analysis by clicking the first entry on the Process Chart. Click a tab to switch between analyses.

Reviewing results

To compare cost results for several processes, we now open another file that was part of your installation of DFM Concurrent
Costing. The file contains five analyses of the same part using several process/material combinations. One of the analyses was
carried out using significantly lower labor and machine costs to simulate relatively low-wage manufacturing conditions.

1. Choose Open from the File menu. In the Windows dialog choose casting comparison.dfmx from the \data\samples folder
and click the Open button.

2. Animage of the part, a faucet body, is included in the Picture box for the top level of the Process Chart.
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3. From the Results menu, choose Cost vs. Life Volume. Once the graph for the current analysis has finished loading, check the
rest of the analyses.

r -
1| Graph Window — ] * 1

EJ@ Nl % O

COSt Vs L|fe V0|ume, $ |%| manual sand casting
|%| auto sand casting

|%| manual sand casting - China
|| die cast

%] investment casting

1000 A

Cost, & for life volume 100000

manual sand casting
Manual sand casting process 4.8319
Generic copper alloy
. auto sand casting
Automatic sand casting process 3.5236
Generic copper alloy
= manual sand casting - China
R Manual sand casting process 4.8319
Generic copper alloy
. die cast
Heot chamber die casting process  2.3181
ZA-8 cast zinc alloy
investment casting
Investment casting process 41370
Generic copper alloy

Total cost,

10 4

f

100000

T T T T
1 100 10000 1000000 100000000

Life volume Right dlick on graph to change life volume

-

4. For each analysis a curve of the total part cost versus the life volume is displayed. Each line is color coded and on the right
panel, the costs for a life volume of 100,000 are displayed.

5. Type 200000 in the life volume field and observe the change in totals and the repositioning of the slider in the graph.

6. Scroll the mouse wheel to zoom in and out of the graph. Press the shift key and outline a rectangle with the mouse to view
more detail of that region. Press the Alt key and click to zoom back out.

7. Notice that right-clicking the graph will move the slide to give costs for different life volumes.
8. Click the toolbar button for Cost Totals bar and observe the cost breakdown for the five analyses.

9. Click the toolbar button for Cost Totals stacked to see the total cost for each analysis. Hovering over the bar segments will
display more detailed cost information.

10. Click the toolbar button Cost Reduction. Choose the investment cast analysis on the right panel.

11. The chart shows the contribution of selected cost drivers to the total cost of the part, which is included in the text summary
beside the graph. You can view reports for any these graphs by choosing Print Preview from the Graphs menu.
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